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1 Цель, планируемые результаты обучения по дисциплине (модулю) 

Цель дисциплины – сформировать у студентов навыки работы с современными 

инструментами для создания медиа контента, включая разработку и создание  медиа 

материалов, адаптированных для восприятия и использования в интернете и других 

цифровых платформах. 

А также дать возможность студентам получить опыт в создании мультимедийного и 

интерактивного контента, где мультимедийность связана с отбором и одновременным 

сочетанием различных способов коммуникации с читателями, включая текст, аудио, видео 

и другие медиаресурсы, а интерактивность предполагает предоставление выбора удобной 

формы представления информации, возможности мгновенной реакции на медиаконтент и 

обеспечение интерактивного диалога. 

Задачи дисциплины: 
- Познакомить студентов с современными инструментами создания медиа контента, 

в том числе с помощью искусственного интеллекта 

- Изучить основные принципы проектирования медиаконтента, включая 

визуализацию данных, мультимедийность и интерактивность. 

- Получить опыт создания мультимедийного и интерактивного контента.  

А также: 

- вовлечение обучающихся в процессы саморазвития и самореализации. 
 - Приобретение навыков формулирования целей и задач научного исследования, 

выбора и обоснования методики исследования; - Формирование навыков 

библиографической работы, самостоятельной работы с различными источниками 

информации; - Проведение анализа, систематизации и обобщение информации по теме 

исследований; - Развитие творческой активности и инициативы студентов.- Вовлечение 

студентов в социальную активность университета, развитие интереса к участию в 

социально-значимых проектах (спортивных, культурных, общественных, экологических 

мероприятиях);- Формирование желания активного участия в волонтерских мероприятиях, 

в оказании помощи нуждающимся;- Формирование эстетического вкуса при обустройстве 

внешней среды во время проведения культурных, общественных, экологических и других 

мероприятий;- Развитие навыков социализации в коллективе; 

Планируемыми результатами обучения по дисциплине (модулю), являются знания, 

умения, навыки. Перечень планируемых результатов обучения по дисциплине (модулю), 

соотнесенных с планируемыми результатами освоения образовательной программы, 

представлен в таблице 1. 

Таблица 1 – Компетенции, формируемые в результате изучения дисциплины (модуля)  

Название 

ОПОП ВО, 

сокращенное 

Код и 

формулировка 

компетенции 

Код и 

формулировка 

индикатора 

достижения 

компетенции 

Результаты обучения по дисциплине 

Код 

резуль 

тата 

Формулировка результата 

54.03.01 

«Дизайн»  

(Б-ДЗ) 

ПКВ-3 : 

Способен 

проектировать 

корпоративную 

айдентику и 

системы 

визуальной 

коммуникации  

ПКВ-3.1к : 

Проектирует 

корпоративную 

айдентику и 

адаптирует ее 

для нужд 

бизнеса в 

цифровой 

среде  

РД1 Знание  Знает различные методы создания 

материалов, адаптированных для 

восприятия и использования в 

интернете и других цифровых 

платформах 
РД2 Умение  Умеет рассказать историю 

визуальным языком, управляя 

фокусировкой внимания зрителей 

на главном в информации через 

иллюстрации, фотографии и 

инфографику. 



РД3 Навык  Имеет опыт создания 

медиаконтента, включая 

визуализацию данных, 

мультимедийность и 

интерактивность. 

В процессе освоения дисциплины решаются задачи воспитания гармонично 

развитой, патриотичной и социально ответственной личности на основе традиционных 

российских духовно-нравственных и культурно-исторических ценностей, представленные 

в таблице 1.2. 

Таблица 1.2 – Целевые ориентиры воспитания  

Воспитательные задачи Формирование ценностей Целевые ориентиры 

Формирование гражданской позиции и патриотизма  

Воспитание уважения к истории и 

культуре России  
Гражданственность  Активная жизненная позиция  

Формирование духовно-нравственных ценностей  

Формирование ответственного 

отношения к труду  
Созидательный труд  

Умение работать в команде и 

взаимопомощь  

Формирование научного мировоззрения и культуры мышления  

Развитие познавательного интереса и 

стремления к знаниям  
Жизнь  Креативное мышление  

Формирование коммуникативных навыков и культуры общения  

Формирование культуры письменной 

речи и делового общения  
Историческая память и 

преемственность поколений  
Любовь к родному языку  

  

2 Место дисциплины (модуля) в структуре ОПОП 

Дисциплина «Проектирование в цифровой среде (id = 47386)» является элективной 

дисциплиной части учебного плана, формируемой участниками образовательных 

отношений у бакалавров направления «54.03.01 Дизайн» по профилю Цифровой дизайн. 

Совместно с другими дисциплинами участвует в формировании общепрофессиональных 

компетенций студента в контексте его будущей деятельности. Дисциплина разработана и 

читается студентам с целью общепрофессиональной подготовки и связана с 

формированием комплекса знаний о процессе создания интерактивного аудио-визуального 

контента с помощью специализированного программного обеспечения, в т.ч. для 

визуального или адаптированного программирования графики. 

3. Объем дисциплины (модуля) 

Объем дисциплины (модуля) в зачетных единицах с указанием количества 

академических часов, выделенных на контактную работу с обучающимися (по видам 

учебных занятий) и на самостоятельную работу, приведен в таблице 2.  

Таблица 2 – Общая трудоемкость дисциплины 



Название 

ОПОП 
ВО 

Форма 

обуче- 
ния 

Часть 
УП 

Семестр 

(ОФО) 

или курс 
(ЗФО, 

ОЗФО) 

Трудо- 

емкость Объем контактной работы (час) 

СРС 
Форма 

аттес- 
тации 

(З.Е.) Всего 

Аудиторная Внеауди- 
торная 

лек. прак. лаб. ПА КСР 

54.03.01 
Дизайн ОФО Б1.В 7 2 41 0 40 0 1 0 31 З 

4 Структура и содержание дисциплины (модуля) 

4.1 Структура дисциплины (модуля) для ОФО  

Тематический план, отражающий содержание дисциплины (перечень разделов и 

тем), структурированное по видам учебных занятий с указанием их объемов в соответствии 

с учебным планом, приведен в таблице 3.1  

Таблица 3.1 – Разделы дисциплины (модуля), виды учебной деятельности и формы 

текущего контроля для ОФО  

№ Название темы 
Код ре- 

зультата 

обучения 

Кол-во часов, отведенное на 
Форма 

текущего контроля Лек Практ Лаб СРС 

1 Основы мультимедийного 

контента: РД1 0 6 0 6 практическая работа  

2 Создание мультимедийных 

презентаций: РД1 0 6 0 6 практическая работа  

3 Разработка интерактивных 

обучающих материалов: РД2 0 6 0 6 практическая работа  

4 Адаптивный дизайн:  РД2 0 6 0 6 практическая работа  

5 Продвижение 

мультимедийного контента: РД3 0 6 0 6 практическая работа  

6 

Продвинутые технологии и 

искусственный интеллект в 

проектировании 

медиаконтента. 

РД3 0 6 0 6 практическая работа  

Итого по таблице  0 36 0 36  

  

4.2 Содержание разделов и тем дисциплины (модуля) для ОФО  

Тема 1 Основы мультимедийного контента:. 

Содержание темы: знакомство с понятием, типами и особенностями 

мультимедийных материалов. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

Тема 2 Создание мультимедийных презентаций:. 

Содержание темы: разработка структуры, подбор изображений и видео, оформление 

текста и таблиц, форматирование и анимация элементов. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

Тема 3 Разработка интерактивных обучающих материалов:. 



Содержание темы: использование гиперссылок, интерактивных элементов и тестов 

для улучшения усвоения материала. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

Тема 4 Адаптивный дизайн: . 

Содержание темы: принципы создания сайтов и приложений, которые корректно 

отображаются на разных устройствах и экранах. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

Тема 5 Продвижение мультимедийного контента:. 

Содержание темы: стратегии продвижения в социальных сетях, поисковых системах 

и на видеохостингах. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

Тема 6 Продвинутые технологии и искусственный интеллект в проектировании 

медиаконтента. 

Содержание темы: В этой лекции будут рассмотрены возможности применения 

передовых технологий и искусственного интеллекта для создания и оптимизации 

мультимедийного контента. Вы узнаете о методах машинного обучения, обработки 

естественного языка и анализа данных, которые помогут вам создавать более качественный 

и актуальный контент для вашей аудитории. 

Формы и методы проведения занятий по теме, применяемые образовательные 

технологии: минилекция, практическое занятие. 

Виды самостоятельной подготовки студентов по теме: повторение пройденного 

материала. 

  

5 Методические указания для обучающихся по изучению и реализации 

дисциплины (модуля) 

5.1 Методические рекомендации обучающимся по изучению дисциплины и по 

обеспечению самостоятельной работы 

Процесс изучения данной дисциплины предполагает выполнение практических 

работ,сопровождающихся демонстрацией видео-уроков и других презентационных 

материалов. Знания, полученные студентами в аудитории, закрепляются и дополняются 

самостоятельнодома, в библиотеке, посредством использования ресурсов глобальной сети 

Интернет.Аудитория должна быть оснащена мультимедийным оборудованием и 

диапроектором. 



5.2 Особенности организации обучения для лиц с ограниченными возможностями 

здоровья и инвалидов 

При необходимости обучающимся из числа лиц с ограниченными возможностями 

здоровья и инвалидов (по заявлению обучающегося) предоставляется учебная 

информация в доступных формах с учетом их индивидуальных психофизических 

особенностей:  

- для лиц с нарушениями зрения: в печатной форме увеличенным шрифтом; в форме 

электронного документа; индивидуальные консультации с привлечением 

тифлосурдопереводчика; индивидуальные задания, консультации и др.  

- для лиц с нарушениями слуха: в печатной форме; в форме электронного документа; 

индивидуальные консультации с привлечением сурдопереводчика; индивидуальные 

задания, консультации и др.  

- для лиц с нарушениями опорно-двигательного аппарата: в печатной форме; в форме 

электронного документа; индивидуальные задания, консультации и др. 

6 Фонд оценочных средств для проведения текущего контроля и промежуточной 

аттестации обучающихся по дисциплине (модулю) 

В соответствии с требованиями ФГОС ВО для аттестации обучающихся на 

соответствие их персональных достижений планируемым результатам обучения по 

дисциплине (модулю) созданы фонды оценочных средств. Типовые контрольные задания, 

методические материалы, определяющие процедуры оценивания знаний, умений и 

навыков, а также критерии и показатели, необходимые для оценки знаний, умений, навыков 

и характеризующие этапы формирования компетенций в процессе освоения 

образовательной программы, представлены в Приложении 1. 

7 Учебно-методическое и информационное обеспечение дисциплины (модуля)  

7.1      Основная литература 

1.    Петракова, Н. В. Основы CSS : учебно-методическое пособие / Н. В. Петракова. 

— Брянск : Брянский ГАУ, 2023 — Часть 2— 2023. — 107 с. — Текст : электронный // Лань 

: электронно-библиотечная система. — URL: https://e.lanbook.com/book/385640 (дата 

обращения: 24.11.2025). — Режим доступа: для авториз. пользователей. 

2.    Пономарев, Н. Ф., Сторителлинг в цифровой транскоммуникации : учебное 

пособие / Н. Ф. Пономарев. — Москва : Русайнс, 2024. — 232 с. — ISBN 978-5-466-04890-

2. — URL: https://book.ru/book/952348 (дата обращения: 18.11.2025). — Текст : 

электронный. 

  

7.2      Дополнительная литература 

1.    Павлов, А. Ю. Как написать хороший сценарий : советы начинающим 

сценаристам : учебное пособие : [16+] / А. Ю. Павлов. – Москва ; Берлин : Директ-Медиа, 

2015. – 400 с. : ил. – Режим доступа: по подписке. – URL: 

https://biblioclub.ru/index.php?page=book&id=375584 (дата обращения: 03.05.2023). – 

Библиогр.: с. 69-72. – ISBN 978-5-4475-5467-5. – DOI 10.23681/375584. – Текст : 

электронный. 

  



7.3      Ресурсы информационно-телекоммуникационной сети "Интернет", 

включая профессиональные базы данных и информационно-справочные 

системы (при необходимости): 

1.    Электронно-библиотечная система "BOOK.ru" 

2.    Электронно-библиотечная система "ЛАНЬ" 

3.    Электронно-библиотечная система "УНИВЕРСИТЕТСКАЯ БИБЛИОТЕКА 

ОНЛАЙН" 

4.    Open Academic Journals Index (OAJI). Профессиональная база данных - Режим 

доступа: http://oaji.net/ 

5.    Президентская библиотека им. Б.Н.Ельцина (база данных различных 

профессиональных областей) - Режим доступа: https://www.prlib.ru/ 

6.    Информационно-справочная система "Консультант Плюс" - Режим доступа: 

http://www.consultant.ru/ 

8 Материально-техническое обеспечение дисциплины (модуля) и перечень 

информационных технологий, используемых при осуществлении образовательного 

процесса по дисциплине (модулю), включая перечень программного обеспечения  

Основное оборудование:  

 Компьютеры  

 Проектор  

Программное обеспечение:  

 Photoshop  
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1 Перечень формируемых компетенций 

Название ОПОП ВО, 

сокращенное 

Код и формулировка компетенци

и 

Код и формулировка индикатора достижения 

компетенции 

54.03.01 «Дизайн»  

(Б-ДЗ) 

ПКВ-3 : Способен проектировать 

корпоративную айдентику и сист

емы визуальной коммуникации  

ПКВ-3.1к : Проектирует корпоративную айде

нтику и адаптирует ее для нужд бизнеса в ци

фровой среде  

  

Компетенция считается сформированной на данном этапе в случае, если полученные 

результаты обучения по дисциплине оценены положительно (диапазон критериев 

оценивания результатов обучения «зачтено», «удовлетворительно», «хорошо», «отлично»). 

В случае отсутствия положительной оценки компетенция на данном этапе считается 

несформированной. 

2 Показатели оценивания планируемых результатов обучения 

Компетенция ПКВ-3 «Способен проектировать корпоративную айдентику и 

системы визуальной коммуникации» 

Таблица 2.1 – Критерии оценки индикаторов достижения компетенции  

Код и формулировка индикат

ора достижения компетенции 

Результаты обучения по дисциплине 

Критерии оценивания результ

атов обучения 

Ко

д 

ре

з- 

та 

Ти

п 

ре

з- 

та 

Результат 

ПКВ-3.1к : Проектирует корп

оративную айдентику и адапт

ирует ее для нужд бизнеса в ц

ифровой среде  

РД

1 

Зн

ан

ие  

Знает различные методы созд

ания материалов, адаптирова

нных для восприятия и испол

ьзования в интернете и други

х цифровых платформах 

Полнота и точность ответа 

РД

2 

У

ме

ни

е  

Умеет рассказать историю ви

зуальным языком, управляя ф

окусировкой внимания зрител

ей на главном в информации 

через иллюстрации, фотограф

ии и инфографику. 

Выполнено практическое зад

ание (текущее) 

РД

3 

На

вы

к  

Имеет опыт создания медиак

онтента, включая визуализац

ию данных, мультимедийност

ь и интерактивность. 

выполнено практическое зада

ние (промежуточное) 

  

Таблица заполняется в соответствии с разделом 1 Рабочей программы дисциплины 

(модуля). 

3 Перечень оценочных средств 

Таблица 3 – Перечень оценочных средств по дисциплине (модулю)  

Контролируемые планируемые рез

ультаты обучения 

Контролируемые темы д

исциплины 

Наименование оценочного средства и пр

едставление его в ФОС 

Текущий контроль 
Промежуточная ат

тестация 



Очная форма обучения 

РД1  Знание : Знает различны

е методы создания мате

риалов, адаптированных 

для восприятия и испол

ьзования в интернете и 

других цифровых платф

ормах  

1.1. Основы мультимеди

йного контента: 

Практическая рабо

та  

Индивидуальное д

омашнее задание  

1.2. Создание мультиме

дийных презентаций: 

Практическая рабо

та  

Индивидуальное д

омашнее задание  

РД2  Умение : Умеет рассказ

ать историю визуальны

м языком, управляя фок

усировкой внимания зри

телей на главном в инфо

рмации через иллюстра

ции, фотографии и инфо

графику.  

1.3. Разработка интеракт

ивных обучающих мате

риалов: 

Кейс-задача  
Индивидуальное д

омашнее задание  

1.4. Адаптивный дизайн

:  
Кейс-задача  

Индивидуальное д

омашнее задание  

РД3  Навык : Имеет опыт соз

дания медиаконтента, вк

лючая визуализацию да

нных, мультимедийност

ь и интерактивность.  

1.5. Продвижение мульт

имедийного контента: 
Кейс-задача  

Индивидуальное д

омашнее задание  

1.6. Продвинутые техно

логии и искусственный 

интеллект в проектиров

ании медиаконтента. 

Кейс-задача  
Индивидуальное д

омашнее задание  

4 Описание процедуры оценивания 

Качество сформированности компетенций на данном этапе оценивается по 

результатам текущих и промежуточных аттестаций при помощи количественной оценки, 

выраженной в баллах. Максимальная сумма баллов по дисциплине (модулю) равна 100 

баллам. 

Суммарно по дисциплине можно получить максимум 100 баллов за семестр.  

Вид учебной 

деятельности  

  

Кейс/задача  Практическая работа  Индивидуальное домашнее задание  Итого  

Текущая аттестация   20  20    40  

Промежуточная атт

естация  
    60  60  

Итого   20  20  60  100  

 

Сумма баллов, набранных студентом по всем видам учебной деятельности в рамках 

дисциплины, переводится в оценку в соответствии с таблицей. 

Сумма балло

в  

по дисципли

не  

Оценка по промеж

уточной аттестаци

и  

Характеристика качества сформированности компетенции  

от 91 до 100  
«зачтено» /  

«отлично»  

Студент демонстрирует сформированность дисциплинарных компетенций, обна

руживает всестороннее, систематическое и глубокое знание учебного материала

, усвоил основную литературу и знаком с дополнительной литературой, рекоме

ндованной программой, умеет свободно выполнять практические задания, пред

усмотренные программой, свободно оперирует приобретенными знаниями, уме

ниями, применяет их в ситуациях повышенной сложности.  

от 76 до 90  
«зачтено» /  

«хорошо»  

Студент демонстрирует сформированность дисциплинарных компетенций: осно

вные знания, умения освоены, но допускаются незначительные ошибки, неточн

ости, затруднения при аналитических операциях, переносе знаний и умений на н

овые, нестандартные ситуации.  



от 61 до 75  

«зачтено» /  

«удовлетворитель

но»  

Студент демонстрирует сформированность дисциплинарных компетенций: в хо

де контрольных мероприятий допускаются значительные ошибки, проявляется о

тсутствие отдельных знаний, умений, навыков по некоторым дисциплинарным к

омпетенциям, студент испытывает значительные затруднения при оперировани

и знаниями и умениями при их переносе на новые ситуации.  

от 41 до 60  

«не зачтено» /  

«неудовлетворите

льно»  

У студента не сформированы дисциплинарные компетенции, проявляется недос

таточность знаний, умений, навыков.  

от 0 до 40  

«не зачтено» /  

«неудовлетворите

льно»  

Дисциплинарные компетенции не сформированы. Проявляется полное или прак

тически полное отсутствие знаний, умений, навыков.  

5 Примерные оценочные средства 

5.1 Примеры заданий для выполнения практических работ 

Практическое задание: технологии создания и редактирования 3D-графики для веб. 

Цель: научиться создавать и редактировать элементы трёхмерной графики для 

внедрения ее в веб-контент. 

Краткие методические указания 

Задание: 

- создайте работу в программном комплексе Blender и выполните анимацию 

трёхмерной сцены 

- экспоритуйте ее для веб и внедрите на тестовую странцу для демонстрации в 

интерактивном виде 

Технические требования: доступ к интернету, компьютер с установленным 

программным комплексом Blender. 

Шкала оценки 

1-20 баллов 

5.2 Пример индивидуального домашнего задания 

Практическое задание: технологии создания и редактирования звука. 

Краткие методические указания 

Цель: освоить начальные навыки записи и редактирования звука. 

Задание: в программе для реадктирования звука (например Audacity)  выполните 

следующие задачи: 

 подготовка аудиодорожек; 

 запись звука с микрофона; 

 удаление шума из звукового файла; 

 манипуляции со звуком (вырезание, копирование, вставка); 

 микширование и разделение звука. 

Технические требования: доступ к интернету, микрофон и компьютер с 

установленной программой Audacity. 

Шкала оценки 

1- 60 баллов 

5.3 Задания для решения кейс-задачи 

Создайте  кликабельный прототип (в Figma, Adobe XD или аналоги) 3-х связанных 

экранов : 

1. Экран №1: Лента/Каталог экскурсий. 

o Показывает персонализированные подборки. 



o Элементы: карточки экскурсий (фото, название, город, рейтинг, 

цена, возможно, аватар гида). 

o Фильтры (город, тема, цена, длительность). 

o Задача:  Сделать ленту визуально вдохновляющей, но не 

перегруженной. Показать «душу» предложения. 

2. Экран №2: Страница гида. 

o Элементы: фото/видео гида, его история и философия (текст), 

список его экскурсий, верификации (подтвержденный ID, отзывы). 

o Задача:  Вызвать доверие и эмоциональную связь. Гиды — 

главное актив, их нужно «продать». 

3. Экран №3: Процесс бронирования (ключевой шаг). 

o Элементы: выбор даты/времени, количество гостей, опции, 

итоговая стоимость, кнопка оплаты. 

o Задача:  Максимальная простота, прозрачность и чувство 

безопасности. Убрать все лишнее 

Краткие методические указания 

Кейс позволит оценить не просто умение рисовать интерфейсы, а  системное 

мышление дизайнера : от анализа и концепции до детальной проработки интерфейса, 

ориентированного на конкретные цели бизнеса и пользователя. 

Шкала оценки 

ВСЕГО - 1 до 20 баллов 

 Глубина анализа:  5 баллов. Логичность UX-тезисов и user flow. 

 Визуальная целостность и эстетика :  5 баллов. Уместность и 

эмоциональность moodboard, продуманность UI Kit. 

 Удобство использования (UI/UX) :  5 баллов. Интуитивность 

навигации, ясность CTA, работа с иерархией информации. 

 Оригинальность и соответствие брифу:  5 баллов. Удалось ли передать 

уникальный дух City & Soul, отличиться от шаблонных решений. 



КЛЮЧИ ПО ДИСЦИПЛИНЕ 

«ПРОЕКТИРОВАНИЕ В ЦИФРОВОЙ СРЕДЕ (ID = 47386)» 

 

1) Ключи к выполнению практической работы «Создание 3D-сцены в Blender и 

веб-внедрение» 

 

Цель: научиться создавать и редактировать элементы трёхмерной графики для 

внедрения ее в веб-контент. 

 

1. Подготовка сцены в Blender  

Создайте простую сцену с плоскостью-полом, несколькими объектами 

(кубы-здания, сферы) и назначьте им базовые материалы через панель Material 

Properties. 

2. Анимация камеры и объектов  

Анимируйте камеру, создав ключевые кадры на 1 и 100 кадре (I → Location), 

добавьте вращение одному из объектов и экспортируйте в glTF 2.0 с включенными 

анимациями. 

3. Веб-внедрение через Model Viewer  

Создайте HTML-страницу с тегом <model-viewer> от Google, загрузите 

туда.glb файл и добавьте кнопки управления вращением и сбросом вида. 

 

Пример минимальной HTML-страницы: 
html 

<!DOCTYPE html> 

<html> 

<head> 

    <script type="module" src="https://unpkg.com/@google/model-viewer/dist/model-

viewer.min.js"></script> 

    <style>model-viewer {width: 100%; height: 500px;}</style> 

</head> 

<body> 

    <model-viewer src="scene.glb" auto-rotate camera-controls></model-viewer> 

</body> 

</html> 

4. Тестирование и публикация 

Протестируйте локально в браузере, затем загрузите файлы на GitHub 

Pages или Netlify для получения публичной ссылки. 

 

 

2) Ключ к решению индивидуального домашнего задания «Технологии создания и 

редактирования звука» 

 

Цель: освоить начальные навыки записи и редактирования звука. 

 

Краткое руководство по работе со звуком в Audacity 

 

1. Подготовка проекта (10 мин) 

Создайте новый проект в Audacity, добавьте 3 дорожки через Tracks → Add New → 

Stereo Track и импортируйте фоновую музыку File → Import → Audio. 

2. Запись с микрофона (10 мин) 

Выберите микрофон в панели устройств, нажмите красную кнопку записи, проговорите 

текст 30 секунд и остановите запись, затем экспортируйте в WAV. 

3. Очистка от шумов (10 мин) 



Выделите участок с тишиной, выберите Effect → Noise Reduction → Get Noise Profile, 

выделите весь трек и примените Noise Reduction с настройками 12 dB, 6.00, 0.15. 

4. Базовое редактирование (10 мин) 

Используйте Selection Tool для выделения фрагментов, вырежьте ошибки (Ctrl+X), 

скопируйте хорошие участки (Ctrl+C) и вставьте (Ctrl+V) в нужные места. 

5. Микширование дорожек (10 мин) 

*Отрегулируйте громкость каждой дорожки слайдерами слева, добавьте fade-in/out через 

Effect → Fade In/Fade Out и экспортируйте финальный микс в MP3 через File → Export → 

Export as MP3. 

 

 

3)  Ключ к решению кейс-задачи по «Созданию доклада на заданную тему». 

 

Используйте краткий гайд по созданию кликабельного прототипа в Figma: 

 

1. Экран каталога экскурсий (20 мин) 

Создайте ленту с 4-6 карточками (фото, название, город, звёзды, цена, аватар 

гида), добавьте плавающую кнопку фильтров вверху и сделайте карточки кликабельными 

для перехода к гиду. 

 

2. Страница гида (15 мин) 

Разместите фото гида в круге, блок «История гида» с текстом-заполнителем, 

горизонтальный скролл его экскурсий и верификационные значки (ID, отзывы, опыт лет) 

с кнопкой «Забронировать». 

 

3. Экран бронирования (15 мин) 

Добавьте селекторы даты/времени, счётчик гостей, финальную стоимость и 

крупную кнопку «Оплатить», уберите навигацию и оставьте только кнопку «Назад». 

 

4. Связывание экранов (10 мин) 

В Figma/XD используйте Prototype mode: соедините карточку → страницу гида → 

кнопку бронирования → экран оплаты, настройте переходы на Slide Left. 
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